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INTRODUCTION

About SAFARI Montage® Live!
SAFARI Montage® Live! is your all-in-one web conferencing platform. Unlike
other applications it is entirely browser based and doesn’t require any
installations or downloads for participants.
SAFARI Montage® Live! is extremely versatile. Thanks to its customizable
screen layouts it is ideal for online meetings, presentations to large audiences,
training and learning. It allows you share standard file types including the
entire Microsoft Office® suite which makes adaptation within any organization
simple and rapid. Rich media applications can be delivered thanks to Adobe
Flash® and video support directly in the online meeting room.
Setting up meetings for account holders is easy and fast, once logged in you
can get started in no more than a single click. You also have the option to
schedule meetings for the future, send out email invitations or even integrate
into your existing project management or LMS software.

What is an Online Meeting?
Online meetings are a new way to communicate using your computer. All
participants can connect to a conference call using their desktop machine,
from their office, from home, from an internet café, from the coffee shop using
their laptop and a WiFi card or from the train using UMTS mobile technology.
Accessibility is always provided.
Accessing is simple. Typically a moderator will send out a normal web address,
just like a normal website. This invitation will have reached you either by email
in a formal invitation or via an instant messenger conversation. Upon clicking
the link your browser will take you straight into the meeting room. Because
SAFARI Montage® Live! is entirely Adobe Flash® based you will not have to
install or download anything to participate, access is instant.
At the heart of every meeting is the multidirectional videoconferencing
capability, which allows you to converse with and see other participants in real
time. Naturally, participation is optional and can be limited to audio only for
people who either don’t have a camera or do not want to be seen.
But real time video conversation is only the beginning. To fully facilitate online
collaboration or training an online meeting allows you to share files, present
Microsoft PowerPoint® presentations, upload multimedia Adobe Flash® files,
communicate via text chat, collaborate via a shared whiteboard, conduct online
questionnaires and a whole lot more. The abundance of tools brings an entirely
new level of productivity to the communication experience.

Presenter features
A wealth of features lies at your fingertips when conducting an online meeting
with SAFARI Montage® Live!

SAFARI Montage® Live! User Manual for Account Holders and Moderators

Revision 2
8 / 61

C5422 Feb. 2009

Real-time Videoconferencing
Connect with your audience like never before through real-time video and
crystal clear audio.
Screen Sharing
Flick a switch to show everyone in the room what’s going on on your
computer. Ideal for software training, joint web browsing and online
collaboration.
Share files
Upload files to the meeting room. Other participants can download them to
their PCs from a central repository.
Record the session
Optionally a session or parts of a session can be recorded and archived. The
experience of watching an archive is the same as having been there on the day.
Ideal for asynchronous content dispersal or post-meeting review.
Get Feedback
Allow participants to text chat or even participate via the videoconferencing
modules.
Present files
Convert any file including Microsoft PowerPoint to Adobe FlashPaper®, upload
it to SAFARI Montage® Live! and discuss the content. Also supports standard
web formats (.swf, .jpg, .png, .gif).
Conduct questionnaires
Get feedback on the issues at hand by conducting an online live poll.
Participants can be prompted to answer multiple-choice questions; the results
are presented in standard visual graphing formats.
Push Web Pages
Proactively open websites or web content on all participants’ screens.
Control your Environment
Adapt the layout of the software to meet your particular requirements just as
you would any other software application. Everyone else is synced up
automatically.
Meeting timer
Optionally, set a meeting time for your sessions and automatically move users
out of the room when the time expires.
Manage Access
Allow and disallow access to all functionality for the whole group or on a userper-user basis.
Quick Start or Schedule Meetings
Start a meeting with a single click or send out email invitations via the
integrated scheduling system.

System Requirements
SAFARI Montage® Live! is designed to be easily accessible from anywhere,
for everyone.
Required
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•
•
•
•

A standard web browser.
Internet connection (56K for audio, ISDN for video, DSL recommended).
Adobe Flash® plug-in.
For exact system requirements please refer to:

http://www.safarimontage.com/support/
Optional
• A speaker system or headphones to listen to any audio broadcasts or
multimedia content.
• A headset or microphone to participate in a conference call.
• A web cam to broadcast video and videoconference.
You can visit http://<yourhostname>/systemcheck/ to check if your system
meets the requirements to participate and your firewall is appropriately
configured.

CHAPTER 1
GETTING STARTED
This “Getting Started” guide will show you how easy it is to set up a session. It
doesn’t cover full functionality but shows you how easy it is to get started.

My first session
This guide will show you how to start a session via Quick Start, later on in the
manual we will explain how to schedule a session and invite users via email
invitation.
3 steps to presenting content on the web
Two clicks and you are in!
1. Log in to your Account Center.
2. Click the “Quick Start a Session” button.
3. Congratulations! You are already in a web conference!
Now let’s invite some friends!
4. In the title bar of SAFARI Montage® Live!, find the “Options” Menu,
select “Copy Session Link”. Click the copy button.
5. Paste the link (CTRL-V on Windows, •-V on Mac) into an email or your
instant messenger.
6. Sit back and wait for them to join you!
Ok, let’s give them a nice show!
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7. To upload file, find the File Share component in the bottom left area of
SAFARI Montage® Live!
8. Click the little cogwheel icon and select “Add”. Select an image or
Adobe FlashPaper® file from your computer and wait for it to upload.
Once uploaded it will appear in the File Share component.
9. Now let’s open the file on everyone’s screen. Click the file in the File
Share component and then press the “Open” button. The file opens on
everyone’s screen.
10. Finally, click the “Start Broadcast” button at the bottom of the Audio /
Video component to start sending Audio and Video! After clicking “Start
Broadcast”, click the “Talk” button if you want to send audio. Click the
little lock to switch to hands-free mode.
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CHAPTER 2
YOUR ACCOUNT CENTER
The Account Center is your main control center. It is your first stop for every session
you initiate. It allows you to start a session in 2 clicks or schedule and email invite
your conferencing partners. You also use it to edit information on meetings and
manage the recordings of your sessions. If you forgot your password you can click
the “forgot password” link on the log in screen and have it emailed to the email
address you registered with.

Setting up a session
You can set up a session in 2 easy ways:
Quick Start
The fastest way to start a web conference:
1. Log in to your Account Center.
2. Click the “Quick Start a Session” button.
Congratulations! You are already in a web conference!
To invite other users find the options menu in the top left corner of SAFARI
Montage® Live! and select “Copy Session Link” and click “Copy” in the
window that displays the link. Then simply paste (CTRL-V on Windows, •-V
on Mac) the link into an email or an instant messenger conversation. You
invitees need do nothing more than click the link they received.
Alternatively you can choose “Send Invitation” from the options menu and
send an email invitation. You can send the email to multiple invitees by
separating the addresses with a comma “,” or semi-colon “;”. You can enter
a Subject and Message to your invitees or use the pre filled text.
Any session you Quick Start is automatically given a date and time stamp
and saved in your meeting schedule for later reference together with all its
files and contents.
Schedule a Conference
Schedule a meeting for the future and send out email invitations.
1. Log in to your Account Center.
2. Click the “Schedule a session” button.
3. Fill in the form:
a. Topic - A descriptive name for the session
b. Start - Date and time of the session
c. Duration – a guideline for participants how long the meeting will
take.
d. Activate timer – check the checkbox if you want to display an in
room timer and to show additional timer options. 3 more fields
will appear.
e. Timer – choose whether the time counts up or down and when
the time should start counting.
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f.

Display friendly reminder – set at what point a warning message
should appear to users informing them their time is about to
run out.
g. Remove users when time is up – check this checkbox if you want
users to be moved out of the session when the set duration has
been used. 2 more fields will appear.
h. When time is up, send Administrators to – enter a URL where
you want administrators to be sent once the time expires.
i. When time is up, send invited user to – enter a URL where you
want invited users to be sent once the time expires.
j. Time Zone (GMT) – if you are dealing with international
audiences this field allows you to specify the start time in
relation to Greenwich Meridian Time (GMT 0).
k. Pwd – If you want to protect the room with a password enter a
value here or press the “generate password” button to have
SAFARI Montage® Live! generate one for you. Leaving the field
blank will leave the room unprotected.
l. Send Email invitation – check the checkbox if you want to send
out email invitations, 2 more fields will appear.
m. To – add all email addresses of people that you want to invite.
Separate recipients with a “,” (comma) or a “;” (semicolon).
n. Msg – Write an invitation message. This will appear in the email
invite.
4. Check the “remember” checkbox if you want SAFARI Montage® Live! to
remember the info you just entered. This is useful if you regularly invite
the same group of people for example.
5. Press Continue, if you decided to send email invitations they will be
sent at this stage.
Congratulations! You have scheduled a conference!
To enter the session, go to your Account Center and click the “View
Schedule” button. Find your session in the list and click on its title.
SAFARI Montage® Live! will automatically take you to your meeting room.

Editing a session or a recording
You can edit a session’s or recording’s title, time, date, password and email
invitations.
Editing a session
1.
2.
3.
4.
5.

Log in to your Account Center.
Click the “View Schedule” button.
Click the Edit icon at the right side of every session.
Edit the details in the form.
Click Continue.

NOTE: If you have the “send email invitation” checkbox checked, emails will
be sent out.
Editing a recording
1. Log in to your Account Center.
2. Click the “View Recordings” button.
3. Click the Edit icon at the right side of every recording.
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4. Edit the details in the form.
5. Click Continue.
NOTE: Changing the password will disallow people who know the previous
password to enter.
The “Trim playback” values (start and end time) allow you to create a
clipping of the recording. Viewers will not see any part of the recording
prior to the start time or after the end time.

Viewing a recording
If you have recorded a session or parts of a session, you can access recordings
via your Account Center.
Viewing a recording
1.
2.
3.
4.
5.

Log in to your Account Center.
Click the “View Recordings” button.
Click the name of the recording you want to watch.
The recording will load, simply click the play button.
You can fast forward or rewind by moving the play head or clicking
anywhere in the play track.
6. You can click the pause button to temporarily pause the playback at a
certain section. Click the play button to start the playback where you
left off.
7. Clicking the stop button will stop the playback and rewind the
recording to the beginning.

Distributing a recording
You can easily send the link to a recording to other people.
Distributing a recording
1. Log in to your Account Center.
2. Click the “View Recordings” button.
3. Right-Click (Mac users CTRL-click) the name of the recording you want
to watch.
4. Select “Copy Link”. The link is copied to the clipboard.
5. You can now paste the link by pressing CTRL-V (•-V on Mac) on your
keyboard into an email, an instant messenger session or even onto any
website.
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CHAPTER 3
INSIDE A CONFERENCE ROOM
The Workspace
When you enter a conference room you will notice a set of windows and a
menu bar. These windows are interactive units, separated by their primary
function within the meeting. We refer to these as “components”.
The first time you enter a room you will see a window with Getting Started tips.
You can stop this window from appearing by unchecking the “Show tips on
startup” check box. You can always show this box via the options menu and
selecting “Getting Started”.

¾

A SAFARI Montage® Live! Session

They can be moved, resized, collapsed and even hidden depending on your
particular necessities.

The Components
The following components are available:
Audio / Video Component
Used for all live audio and video communication.
Userlist
See who and how many people are connected to the room.
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Content Viewer
All content is shown in this window. Account Holders and Moderators can
control content and a message shows everyone who is currently leading.
File Share
Files can be uploaded and shared with the group. If you open a file it will open
in the content viewer.
Screen Sharing
You can broadcast your screen by clicking the “Start Sharing” button at the
bottom of this window.
Chat
All users can use the text chat to communicate with you and each other,
provided they have been given access.
URL Push
Add websites to a central repository for all users to see. You can proactively
open websites on other users’ computers.
Live Polling
Create online questionnaires on-the-fly and make your online presentations
more interactive and engaging.

Meeting Roles
A SAFARI Montage® Live! Conference Room is an interactive environment where
everyone can participate depending on the role they are assigned. We can
distinguish between 4 roles: Account Holder, Moderator, Participant and
Observer.
The person creating the room is the Account Holder. Invitees typically enter as
Observers and can be promoted to a higher user level at any time.
Each component has different right allocations per user type. These are
explained in each relevant section of the user guide. The following table
illustrates some system wide rules.

Account settings
Top-Up Credit
Promote Users to Moderator
Screen Layouts
Show / Hide Modules
Invite Users
Kick / Ban Users

Account
Holder
9
9
9
9
9
9
9

Moderator

Participant

Observer

9
9
9
9
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The Title Bar
The title bar is an integral part of every meeting. It offers access to several
important features and also gives feedback on connection status of the
application and meeting events.
The left side of the title bar is dedicated to the application menus. The right
side provides notifications on events and connection status.

The Menu
Options
> Send Invitation
> Copy Access Link
> Getting Started
Settings
> Camera
> Microphone
> Access
Workspace
> Preparation View
> Presentation View
> Discussion View
> Screen Share View
> Custom View
> Save Current as Custom
> Show Components
Rights Management
> Selected User
> Change Status
> Moderator
> Participant
> Observer
> Audio /Video
> Chat
> Fileshare
> Participants
> Content Viewer
> Screen Share
> URL Push
> Ban Permanently
> Set Moderator Rights
> Set Participant Rights
> Set Observer Rights
Connection Status
A green light in the top right of the Title Bar indicates you are connected to
the application.
A red light will light up if you are disconnected, accompanied by a pop-up
message. Reconnect by refreshing your browser window.
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Using Components
You can hide and show components using the workspace menu in the title bar.
This can be done in two ways, either by selecting a predefined workspace
layout or by individually selecting and deselecting modules from the “show
components” submenu.

Collapse
Context sensitive
menu

Maximize / Minimize
Title Bar

Resize Handle
¾

A component window

All components share some basic functionality.
•
•
•
•
•

They can be moved by clicking and dragging their title bar.
They can be collapsed by clicking the triangle icon on the top left of
their title bar.
They all have their individual, context sensitive menu in the cogwheel
icon in their title bar.
They can be resized by clicking and dragging their resize handle in the
bottom right of each component.
They can quickly be maximized to take the full screen space by clicking
the icon in the top right corner. Clicking again will return it to its
previous size.

This functionality is reserved for Account Holders and Moderators only, with
exception of the context sensitive menu, which is displayed to other user types
with reduced options.

Modifying your workspace
You can hide and show components using the workspace menu in the title bar.
This can be done in two ways, either by selecting a predefined workspace
layout or by individually selecting and deselecting modules from the “show
components” submenu.
Any changes you make to the workspace are immediately visible to all
connected users, unless you are in “Preparation Mode”, which you can turn on
via the workspace menu in the title bar.
Preparation Mode
If you move, resize or collapse windows while you are in preparation mode
no one will see what you are doing, as soon as you turn preparation off
again everyone will be synced to the layout you have just created.
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Predefined Layouts
You can easily switch between predefined layouts in the workspace menu in
the title bar. SAFARI Montage® Live! comes with three layouts, designed for
the three most common uses: Presentation View, Discussion View and
Screen Share View.
Presentation View focuses the attention of the audience on the Content
Viewer window and gives easy access to files.
Discussion View removes all elements from stage except the Audio/Video,
Chat and Participants list components. It is the perfect view for a
straightforward videoconference.
Screen Share View opens a large area for sharing your screen. The
Audio/Video module automatically switches to audio only mode to save
bandwidth. This can be overridden in the Audio/Video module.
Remember you can always add and remove components through the
Workspace > Show Components menu in the title bar.
NOTE: If the layouts differ from the ones described here your system
Account Admin has altered them to better serve your organization’s
requirements.
Custom Layouts
If the predefined layouts are not enough and you frequently use a custom
layout SAFARI Montage® Live! has an inbuilt feature which will make your
life a lot easier.
1. Create the layout you prefer by dragging, resizing and collapsing
the components as you see fit.
2. In the Workspace menu, select “save current as custom”.
This layout is now saved as your custom layout. Whenever you want to
return to this layout simply select “Custom View” from the workspace menu
in the title bar.
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CHAPTER 4
THE AUDIO / VIDEO COMPONENT
The Audio / Video Component allows you to video and audio conference in real time.
You can use it to give presentations to huge audiences or to talk with colleagues in a
private environment.
The video shape & size can be configured to meet your particular bandwidth/quality
requirements and/or the amount of people that are broadcasting video at the same
time. There is also an audio/picture mode which allows speakers to upload a photo
in case they don’t have a web cam or don’t want to send video yet still create a more
personal connection to their audience.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types
have different access levels to this component. The following table summarizes
the differences:

Set Broadcast Type (Audio, Picture,
Video)
Set Video Shape & Size
Upload Image
Zoom Level
Stop Other Broadcasts
Start broadcast without permission
Start broadcast with permission
Push-To-Talk / Hands-Free Mode
Stop your broadcast
Pause your video broadcast
Mute your audio broadcast
Pause others video
Mute others audio

Account
Holder

Moderator

9

9

9
9
9
9
9

9
9
9
9
9

9
9
9
9
9
9

9
9
9
9
9
9

Participant

Observer

9
9

9
9

9
9
9
9
9
9
9

About Audio and Video on the Internet
Advances in compression technology and the increase in available bandwidth
allow the Internet to be used as a broadcast and communication medium.
To ensure the best possible quality, some factors should be considered.
Bandwidth
One basic rule applies. More bandwidth is better. However, network
conditions can vary depending on the location you log in from, the time of
the day or the audience you are addressing so it is important to be aware
of this factor.
SAFARI Montage® Live! allows you to modify your broadcast medium and
adjust your video quality settings on the fly to best meet your particular
requirements and ensures everyone has a perfect experience.
Hardware
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To make sure your video and audio reach your audience at the best
possible quality the input signal first needs to be converted to a low filesize Internet format. SAFARI Montage® Live! will do this for you without you
even noticing but it will need your computer to do the heavy lifting.
Video and audio encoding can be tasking process and it is important to
meet the minimum requirements to be able to ensure the best possible
experience. Again, a faster computer will allow you to send higher quality
video and increase the effectiveness of your online meetings. Similarly it is
important for your audience to have decent machines to be able to receive
the video, although generally it is not as taxing on a computer to receive
(decode) the video as it is to encode it.
Of course, even the most intelligent compression algorithms cannot
achieve high fidelity image or sound if the base signal is of low quality.
Make sure you buy good quality web cams and headsets / microphones;
this will have a huge impact on the quality of your broadcasts.
Software
SAFARI Montage® Live! relies on the ubiquitous Adobe Flash Player® as a
delivery medium. This player is constantly updated, every update brings
with it huge leaps in performance. We recommend always using the latest
version for best performance. We do realize that this is not always possible
so SAFARI Montage® Live! will also work with older versions, starting from
version 7 onwards.
Firewalls
Firewalls are designed to allow only the type of information through that
your organization requires. SAFARI Montage® Live! will allow you to
connect through almost any firewall. More detailed in information for
system administrators is available here:

http://www.safarimontage.com/support/
SAFARI Montage® Live! System Check
An online system check is provided which tests all these requirements in an
instant. Simply point your web browser to:

http://<yourhostname>/systemcheck/
You will get instant feedback whether your PC and Internet connection are
suitable to take part in a SAFARI Montage® Live! web conference.

Configuring your Audio and Video
You need a microphone or headset to send audio and a web or video camera to
send video. It is essential you take some time to set-up and test your system
the first time you use it to make sure everything is configured correctly and
you become acquainted with the software. You can do this either manually or
by running through the set-up wizard.
Set-up Wizard
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Go to the options > Set-up Wizard in the Title Bar menu and follow the
instructions on screen, your audio and video will automatically be
configured to best meet your system specifications.
It is recommended to follow these instructions at least once to fully
understand the different options available. You will also be able to see and
hear what you look and sound like to other users.
Manual Configuration
In some cases you may want to change just a single setting like select a
different web cam or turn your microphone level down in a crowded room,
in this case use the manual configuration settings for quick access.
The following options are available through the “Settings” menu in the Title
Bar.
Camera The Macromedia Flash Player Settings window opens. Select your
preferred camera from the dropdown menu.
NOTE: If you have the screen sharing driver installed it will appear in this
list as “SAFARI Montage® Screen”, selecting it will broadcast your screen
through the video conferencing window. This is not recommended.
Click “Close”.
Microphone The Macromedia Flash Player Settings window opens. Select
your preferred microphone from the dropdown menu. You can reduce your
broadcast volume by moving the slider left and increase your broadcast
volume by moving it to the right. While speaking into the microphone you
will see a colored bar moving up and down. Adjust the microphone so that
the bar is not constantly in the red area.
Click “Close”.
Access The Macromedia Flash Player Settings window opens. You can allow
or deny access to your computers microphone and camera. Make sure this
is set to allow, we recommend selecting the “Remember” Checkbox.
Click “Close”.

Sending Audio and Video
Once your audio and video are properly configured you are ready to go.
Starting your Broadcast
1. Locate the Audio / Video component. By default it is in the top
left corner of the application but depending on the particular
room set-up or current view its position may have changed.
2. Click the “Start Broadcast” button.
3. Depending on your settings, the Macromedia Flash Player Settings
window may appear. Click “Allow” when asked whether access to
your microphone and camera should be allowed.
4. Your broadcast will appear in the Audio and Video component,
clearly identified with your username. All users will be able to see
your broadcast exactly the same way you do.
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5. To send audio, click and hold the “Talk” button. You can also click
and hold the CTRL button (CMD button on the Mac) to activate
your microphone. To switch to hands-free mode click the lock
icon. The button turns green when you are sending audio.
NOTE: When broadcasting audio in hands-free mode, make sure you
and you are wearing a headset or using an echo-canceling
microphone. Failure to do so may result in echoes as audio feeds back
from your speakers into your microphone. If you hear echoes, ask all
users without headsets to use the Push-to-talk feature rather than
hands-free mode.
The broadcast you send could be video, picture or audio, depending
on what has been selected and the display will vary accordingly. See
the explanation for “Broadcast Settings” below.
Regardless of which mode is selected, you will always see a green bar
representing your microphone activity.
Stopping your Broadcast
1. Click the “Stop Broadcast” button.
2. Your broadcast will disappear from the Audio and Video
component.

Controlling Audio and Video Broadcasts
SAFARI Montage® Live! offers several additional controls over audio and video
broadcasts. You can mute your own voice and pause your video, you can
choose whose streams you want to receive and as an Account Holder or
Moderator you can turn off other people’s broadcasts.
You may need to temporarily pause your video or mute your audio for reasons
of privacy or to save bandwidth. Similarly you may choose to stop receiving
other user’s video to save bandwidth or mute another user’s audio because
their microphone is transmitting disturbing sound. SAFARI Montage® Live!
provides a solution for all of these scenarios.
Pausing your Video
1. Click on your own video window.
2. A crossed through video camera icon will appear on top of your
video, your video is now paused and no one else will receive it.
3. Click on your video window again to resume your broadcast.
Muting your Audio
1. Let go of the Talk button or the CTRL key (CMD key on the Mac)
or click the lock icon if you activated the hands-free icon. The
button will turn from green to color-less.
Stop receiving another user’s Video
1. Click on the user’s video window whose video you want to pause.
2. A crossed through video camera icon will appear on top of that
user’s video. You are now no longer receiving that person’s video.
This does not influence what everyone else sees.
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3. Click on their video window again to resume receiving the
broadcast.
Stop receiving another person’s Audio
1. Click on the microphone icon in the broadcast window
underneath the username of the user whose audio you want to
stop receiving.
2. The icon will appear as crossed through; you are now no longer
receiving that person’s audio. This does not influence what
everyone else hears.
3. Click on their microphone icon again to resume receiving the
broadcast.
Stop other users’ Broadcasts
1. Click on the cogwheel icon in the Audio / Video component to
expand the context sensitive menu.
2. Select “Stop Other Broadcasts”.
3. Everyone except you will be removed from the Audio / Video
component.

Working with different Broadcast Modes
To offer you full flexibility depending on any bandwidth or hardware
restrictions you may meet on a day-to-day basis depending on your particular
use scenario, SAFARI Montage® Live! gives you several broadcast modes to
choose from.
By default a room is set to video mode, but it is easy to switch to audio or
image mode.
Switching between broadcast modes
1. Click on the cogwheel icon in the Audio / Video component to
expand the context sensitive menu.
2. Select “Broadcast Type” and in the sub menu choose the mode
you want to switch to.
3. Everyone in the room will be switched to the new mode.
Video Send and receive video and audio.
Audio Send and receive only audio. This uses significantly less bandwidth
and conversation may be more responsive in low bandwidth situations.
Image Allow users to upload an image to be displayed with their audio
broadcast. This image can be either a photo or some other graphical avatar
and can be used to create a more personal connection with your audience
when video is not available either because you don’t have a web cam or
want to save bandwidth.
Uploading an Image for Image Mode (Flash Player 8 or higher)
1. Click on the cogwheel icon in the Audio / Video component to
expand the context sensitive menu.
2. Select “Upload Image”.
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3. A file browser window opens which allows you to select an image.
Choose any .jpg, .gif or .png file on your system. SAFARI
Montage® Live! will upload it, resize it and display it in the Audio
/ Video module.
4. When you broadcast, everyone in the room will be able to see
your image. Additionally, SAFARI Montage® Live! will save the
image with your user account, so you don’t need to upload the
image every time.
Setting Shape & Size
Account holders and Moderators can change the shape and size of the
communication windows; this is most commonly used for video, but also
works in image and audio modes. The default setting is widescreen/small.
You can choose between three shapes – widescreen, portrait and landscape
- in small, medium and large sizes. Depending on your screen layout and
available bandwidth you can choose any of these settings, all users in the
room will be switched to that new format.
1. Click on the cogwheel icon in the Audio / Video component to
expand the context sensitive menu.
2. Select “Shape & Size” and in the sub menus choose first the shape
and then the size you want to switch to.
3. Everyone in the room will be switched to the new setting.
Widescreen A cinema style 16:9 video format.
Portrait The standard newsreader or “passport photo” 8:10 format.
Landscape The standard TV 4:3 format.
Working with Zoom Level
Not to be confused with shape and size, zoom level is a local setting that
allows you to blow up another user’s video. This is useful when you are for
example sharing one screen with other users and bandwidth limitations do
not allow you to broadcast at a higher resolution.
Zoom multiplies the broadcast image by 2 or 3. This setting only applies to
your own computer and will not affect other users. It in no way alters the
signals sent over the network connection and has no effect on bandwidth
used.
1. Click on the cogwheel icon in the Audio / Video component to
expand the context sensitive menu.
2. Select “Zoom Level” and in the sub menus choose the amount of
multiplication you would like to apply to the broadcasts.
3. The broadcast windows on your screen will be switched to the new
setting. Other users will see no change.
Using an External Video Source / Streaming On2 VP6 and H.264 video
SAFARI Montage® Live! allows you to encode and stream video using the
high quality video codecs On2 VP6 or H.264. You can do this using an
external video encoder such as the free Adobe® Flash Media Encoder (FME).
You can download FME from Adobe’s website.
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Please refer to the FME documentation on how to use it; this manual will
describe how to configure SAFARI Montage® Live! to receive and stream
FME video to all connected users.
1. Select the shape & size at which you want to broadcast the video
from the external video source by following the steps described
above.
2. Click on the cogwheel icon in the Audio / Video component to
expand the context sensitive menu.
3. Select “External Video Source”.
4. Click Start Broadcast. A pop-up will appear which gives you the
values you need to insert into Flash Media Encoder. Make sure you
copy these exactly as they appear including stream name, size and
rtmp string.
5. Once you click start in FME you will stream video to all SAFARI
Montage® Live! users. You will NOT receive video yourself to save
bandwidth and CPU, you will see an avatar icon with a text reading
“External Video”.
NOTE: To change the video shape & size you must stop the broadcast both
in SAFARI Montage® Live! and in FME and repeat steps 1-4 as above. If you
have an Enterprise Server License and have access to the Product
Administration Screens you can configure SAFARI Montage® Live! to stream
at any resolution your video hardware and bandwidth support, including
HD video.
On low bitrates you will achieve the best results using the On2 VP6 codec,
on higher bitrates you should opt for H.264. It is generally considered best
to start at a low setting, test, and work your way up to see how far you can
push your bandwidth.
Video encoding with FME can be very CPU intensive. A dedicated, high spec
machine is recommended.
Please refer to our FAQs for more information and a more detailed guide
on how to set up FME for best results.

Managing User Access to the Audio / Video Component
Not everyone is given the option to broadcast Audio and Video by default;
different user types have different access rights to the component.
Account Holders can broadcast at any time by clicking the start broadcast
button.
Moderators can broadcast at any time by clicking the start broadcast
button.
Participants can request to speak at any time by clicking the start broadcast
button. Account Holders or Moderators have to accept their request before
they can start their broadcast.
Observers cannot see or click the start broadcast button.
Accepting a request to speak
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If Participants request to speak an icon appears in the title bar. By clicking
the icon you reveal a list of users waiting for their turn. You can choose
whom you want to give access, whom you don’t and in what order.
1. Click on the Request to Speak icon in the SAFARI Montage® Live!
Title Bar.
2. A list of users requesting to speak will appear.
3. Select a user from the lists.
4. Click “Accept”.
5. The users broadcast will appear in the Audio / Video Component.
Denying a request to speak
Denying access is just as simple as accepting it.
1. Click on the Request to Speak icon in the SAFARI Montage® Live!
Title Bar.
2. A list of users requesting to speak will appear.
3. Select a user from the lists.
4. Click “Deny”.
5. The user disappears from the list, the request is cancelled and the
request window on his or her screen disappears.
Giving users access to the Audio / Video Component
Use the Rights Management menu to turn users into Moderators or
Participants to allow them to see and use the “Start Broadcast” button.
Alternatively you can just change a particular user’s or a particular user
type’s settings to allow access to the Audio / Video Component.
Refer to the chapter on Rights Management for further instructions on how
to do this.
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CHAPTER 5
THE PARTICIPANT LIST COMPONENT
It is important you know who is taking part in the meeting, having an overview over
how many people are connected and knowing what user has what role in the
meeting. These functionalities, including the option to remove users from the
meeting, are provided by the Participant List Component.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types
have different access levels to this component. The following table summarizes
the differences:

See who is connected
See how many people are
connected
See user types
Change my name
Remove User

Account
Holder
9

Moderator

Participant

Observer

9

9

9

9

9

9

9

9
9
9

9
9
9

9
9

9
9

Identifying Users
Depending on the method of invitation and your particular account settings a
user will enter with a different user type and name. The default setting for
invited users is “Observer”. The person who created the room is typically an
“Account Holder”.
A user who was invited via an invitation email will typically enter identified by
his email address; this address will appear as his username in the Participant
List. Users who were invited via the “Copy Session Link” functionality will
typically enter as a guest and identified as such in the Participant List.
Changing User Names
To be able to better identify users, every person connected to a conference
can change their user name.
You can change your user name at any time.
1. Click on the cogwheel icon in the Participant List component to
expand the context sensitive menu.
2. Select “Change my name”.
3. A window opens prompting you to enter your name.
4. Enter the name you would like to identify you in this conference.
5. Click “Apply”.
6. The window will close and your name will change, visible to all
users.

Identifying the number of users connected
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The number of connected users is displayed in the bottom left of the
Participant List Module, next to a user icon. This number updates the
moment someone connects or disconnects to the room.
Removing a User from the Room
There are two ways of doing this, one is to “kick” a user out of the room,
and the other is to permanently “ban” him from re-entering. The difference
is that a kicked out user can re-enter immediately whereas a banned user
has to wait at an hour before he is allowed back in.
Kick a User
1. Select him/her in the Participant List by clicking on his/her name.
2. Click the “Remove User” button in the bottom right of the
Participant List.
3. The user will disappear from the list and be disconnected from the
session.
Permanently Ban a User
1. Select him/her in the Participant List by clicking on his/her name.
2. In the SAFARI Montage® Live! Title Bar click on the Rights
Management menu, choose “Selected User” and click on the “Ban
Permanently” option.
3. The user will disappear from the list and be disconnected from the
session. He or she will not be able to re-enter for one hour.
Changing a User’s Status
If you want to change the rights of a user within the application, you do
this via the Rights Management Menu in the SAFARI Montage® Live! Title
Bar.
1. Select the user in the Participant List by clicking on his/her name.
2. In the SAFARI Montage® Live! Title Bar click on the Rights
Management menu, choose “Selected User” and in the submenus
choose “change Status” and the User Type you want to turn that
user into.
3. The user’s icon will change in the Participant List to reflect the
status he has received and his screen will update with the new
options you have assigned to him/her.
Refer to the chapter on Rights Management for more info.
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CHAPTER 6
THE CONTENT VIEWER COMPONENT
When displaying any type of document based content in SAFARI Montage® Live!, be it
video files, images, Adobe FlashPaper® or anything else, it will be displayed in the
content viewer. Typically you will load documents in from the File Share Component,
which is discussed in the next chapter.
The component gives you feedback on who is “leading” the presentation. By default
Account Holders and Moderators can control content in the Content Viewer.
The Content Viewer also contains a multi user whiteboard which can be used to
mark-up any content.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types
have different access levels to this component. The following table summarizes
the differences:

Load content
Clear content
Show / Hide whiteboard
Control Content
Work Alone / Follow Others

Account
Holder
9
9
9
9
9

Moderator

Participant

Observer

9
9
9
9
9

9
9
9
9

9
9
9
9

Sharing Content
Account Holders and Moderators can control content by default. All users will
be able to see any files that are opened or any time a document is moved to
the next page, scrolled, zoomed in and out or otherwise manipulated. A
message notifies all users who was last to manipulate the document.
Loading a File into the Content Viewer
Files are added to the File Share Component and then loaded into the
Content Viewer Component. .swf, .jpg, .gif, .jpg formats are supported by
the Content Viewer Component. Microsoft Office documents (.ppt, .doc,
.xls) can be converted by SAFARI Montage® Live! to be loaded into the
Content Viewer (requires SAFARI Montage® Live! document converter).
1. Locate the File Share Component.
2. Select the File you want to open for the group (make sure you are
leading the session).
3. If the file is supported by SAFARI Montage® Live!, click the “Open”
button. The button is not visible if you cannot load the selected
content into the Content Viewer. If the file can be converted, click
the “Convert button” and wait for the file to convert, and then
open the converted .swf file.
4. The file opens on all users’ screens.
5. Account Holders and Moderators can see controls to navigate
through the document. These controls may vary depending on the
loaded document file type.
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Working Alone
In some cases you may want to work alone, without having to follow along with
the presentation, for example if you need to review a document before sharing
it with the group or if you want to flick back a few slides in the currently
loaded presentation.
Working alone
Account Holders and Moderators can “break free” from following along with
the leader’s content, and as soon as they choose, can get synced up with
everyone else again.
1. Click on the “Work Alone” button.
2. The button will change to “Follow others” and you will no longer
receive updates from other user’s changes to the content viewer.
Follow others
At any time you can choose to follow the leader of the room again and see
exactly what everyone else is looking at.
1. While being in work alone mode, click on the “Follow Others”
button.
2. The button will change to “Work Alone” and you will be synced up
with the leader of the session. If there is no leader at this point in
time you will see no change.
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Marking Up Content
SAFARI Montage® Live! provides a multi user whiteboard directly in the Content
Viewer to mark up content, collaborate and teach.
Showing the Whiteboard
You can use it in front of a blank, white background or overlay it over any
content you have loaded into the Content Viewer component.
NOTE: While the whiteboard is visible the content in the Content Viewer is
locked. Hide the whiteboard to unlock content.
1. Click on the cogwheel icon in the Content Viewer component to
expand the context sensitive menu.
2. Select “Show/Hide Whiteboard”.
3. The Whiteboard will appear in the Content Viewer. It will always
appear above any content you may have loaded into the Content
Viewer.
Hiding the Whiteboard
The Whiteboard can be hidden at any time. Content will not be erased, if
you show it again at a later stage you will find it exactly the way you left it.
1. Click on the cogwheel icon in the Content Viewer component to
expand the context sensitive menu.
2. Select “Show/Hide Whiteboard”.
3. The Whiteboard will disappear in the Content Viewer.
Using the Whiteboard
An extensive toolset is available in the Whiteboard. Anything you write or
draw will be visible to other users as soon as you press a key or release the
mouse button. Only Account Holders and Moderators can use the
Whiteboard. You can give individual users access to the whiteboard by
using the Rights Management menu. See the chapter on Rights
Management on further instructions.
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Selector
The selector tool can be used to select multiple shapes at once, by clicking
on the stage and then dragging over the shapes. If all the shapes selected
are of the same type the toolbar for that shape will be visible, so specific
shape properties such as fill, line etc can be edited at once. All these
shapes can be dragged at the same time and will be moved relatively using
this tool.
Text
The text tool allows textual annotation on the board; it features
customizable text, font color and font size. To use this tool select it and
drag it on the stage, this tool has a minimum size of 40 * 22. Because the
text area is selectable the method of dragging this tool is different to other
tools, it has a custom editor with a circle handle in the middle for dragging.
Stamp
The stamp tool has a selection of shapes that are useful in diagrams,
meetings and online classes. The stamp tool has a minimum size of 16*16.
Freehand
The freehand tool enables any shape to be drawn, because of the nature of
a freehand it has no resizing capabilities; its editor draws a rectangle
around the shape to make it obvious when it’s selected.
Line
The line tool is great for flow charts or some kind of visual model for any
represented schedule or flow diagram. You can turn on an arrow at the
beginning and/or end of any line by clicking the arrow buttons in the
toolbar. This shape is completely resizable with customizable thickness
and color.
Rectangle
A fundamental shape for drawing, data visualization, etc. Its variables
include fill color, line color and line thickness and is completely resizable.
Oval
The oval tool is another fundamental shape. It also includes fill color, line
color and line thickness as customizable properties.
Triangle
A basic shape with similar properties to rectangle and oval, fill color, line
color and line thickness however it also includes the type of triangle. It can
be an equilateral triangle or a right-angled triangle.
Eraser
You can delete individual items by pressing the delete key on your
keyboard. To quickly clear the entire whiteboard click the eraser tool.
Moving Elements
The arrow keys can be used to move shapes on the whiteboard, up, down,
left and right can be used to move one shape or a selection of shapes. By
using the shift key the shapes will move 10 pixels instead of 1 single pixel.
To delete a shape you can also use the delete key to remove a shape or a
selection of shapes.
Paging
You can create and view different drawings by clicking on the left and right
arrows at the bottom left of the whiteboard. If you are on the last page,
clicking the right arrow will automatically create a new page.
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Content Types
The Content Viewer Component natively supports multiple file types. The most
commonly used files are Adobe FlashPaper® documents, standard image
formats (.jpg, .gif, .png) and Adobe Flash® files (.swf). Microsft Office
documents (.ppt, .xls, .doc) can be uploaded to SAFARI Montage® Live! and
converted via the file share module.
When opening documents, SAFARI Montage® Live! will provide you with file
type specific controls to navigate and manipulate them.

Adobe FlashPaper®
Adobe FlashPaper® allows you to create a SAFARI Montage® Live!
compatible document from inside any application. If you are familiar with
Adobe PDF writer you will already be acquainted with this workflow. It is
similar to printing a document except that you will save a file on your PC
which you can then upload to SAFARI Montage® Live! to be shared with a
group of people. See the Adobe FlashPaper® documentation
(www.adobe.com) for full information.
SAFARI Montage® Live! automatically detects Adobe FlashPaper® and allows
you to use all its functionality including paging, scroll, zoom and search in
a multiuser environment.
Simply load any Adobe FlashPaper® into the content viewer and you will see
the controls. If you are in control of the Content Viewer and paging,
scrolling, zooming or search activity will be propagated to all users.
This is the most common method of using SAFARI Montage® Live! to give
an online presentation.
Image Files
You can load any .jpg, .gif or .png image file that you have created in any
program into the content viewer. The image will automatically resize to fit
the height and width of the Content Viewer window.
SWF
Adobe Flash® files are one of the most commonly used formats for online
presentations, eLearning programs and animations. The support for video
is rapidly turning Adobe Flash® into the preferred method of delivering
video on the web.
You can load any Adobe Flash® file into SAFARI Montage® Live! It will
automatically resize to fit the height and width of the Content Viewer.
Microsoft Office®
Microsoft Office® files are the most commonly used file format in day-today activities. Simply load your document into SAFARI Montage® Live! and
click the convert button in the file share menu to display the file in SAFARI
Montage® Live!
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If you are sharing a PowerPoint file all animations, transitions and sound
effects will be preserved.
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CHAPTER 7
THE FILE SHARE COMPONENT
Any content you add to a SAFARI Montage® Live! meeting is added to the File Share
Component. You can add any type of content to a SAFARI Montage® Live! meeting.
File types, which can be displayed directly in a SAFARI Montage® Live! meeting room,
will be displayed in the Content Viewer Component. Any other file type can be saved
by each connected user, provided they have the appropriate permissions.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types
have different access levels to this component. The following table summarizes
the differences:

Add Files
Delete Files
Delete All Files
Open Files
Convert Files
Cancel an upload
Save Files
Sort Files

Account
Holder
9
9
9
9
9
9
9
9

Moderator

Participant

Observer

9
9
9
9
9
9
9
9

9
9

9

Supported File Types
Any file can be added to the SAFARI Montage® Live! system unless explicitly
barred by the system administrator. In most cases potentially harmful files
such as .exe or .bat files will have been restricted to avoid misuse of the
application. All standard files can be uploaded including all your Microsoft
Office® files, Image Files or other industry specific files you may need to share
with the meeting participants.
Files supported by the Content Viewer
You can present Adobe FlashPaper® files, Adobe Flash® files and any web
image format (.png, .jpg, .gif) using the content viewer component. You
can also upload Microsoft Office documents (.ppt, .xls, .doc) and convert
them to an SAFARI Montage® Live! compatible format directly within SAFARI
Montage® Live! See the chapter on the Content Viewer to find out how to
load files into the content viewer.

Managing files
When a file is added to a meeting room the File Share component provides
visual feedback in the form of file type icons to facilitate its use.
Please note that uploading or downloading a file occupies your bandwidth and
may have adverse effects on any broadcasts you are sending or receiving. It is
recommended practice to upload any files prior to a broadcast.
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You can sort files by file type or file name by clicking onto the file icon or the
“Session Files” title respectively.
Adding a file (Flash Player 8 or higher)
You can add any file on your computer to the meeting room.
1. Click on the cogwheel icon in the File Share component to expand
the context sensitive menu.
2. Select “Add”.
3. A file browser opens which allows you to select a file from your
computer. Select a file by clicking on it. You can choose multiple
files by clicking CTRL or SHIFT while selecting the files.
4. Click “Select”.
5. The browser window closes and you will see a status bar in the
bottom of the File Share component. Hover over the bar to see
which file is uploading. If you have selected multiple files they will
upload one after the other.
6. Once a file has finished uploading it will appear in the File Share
component.
Canceling an upload
You can cancel any of your uploads at any time.
1. While a file is uploading click on the cogwheel icon in the File
Share component to expand the context sensitive menu.
2. Select “Cancel upload”.
3. The upload is cancelled. The file will not be uploaded to the
meeting room.
NOTE: If you are uploading several files you are provided with the options
to “Cancel this upload” or “Cancel all uploads” in Step 2. Choosing “Cancel
this upload” will cancel the file that is currently uploading and moves
straight to the next. Choosing “Cancel all uploads” will cancel all uploads.
Deleting a file
You can delete any file in the meeting room at any point in time.
1. Select the file you want to delete by clicking on it in the File Share
component.
2. Click on the cogwheel icon in the File Share component to expand
the context sensitive menu.
3. Select “Delete”.
4. An alert window opens. Click “Yes”.
5. The window closes and the file is deleted from the room.
Deleting all files in a room
You can quickly delete all files in the meeting room at any point in time.
1. Click on the cogwheel icon in the File Share component to expand
the context sensitive menu.
2. Select “Delete All”.
3. An alert window opens. Click “Yes”.
4. The window closes and all files are deleted from the room.
Saving / downloading) a file to your computer
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Any file within the meeting room can be saved to your computer.
1. Select the file you want to save by clicking on it in the File Share
component.
2. Click the “Save” button.
3. A browser window opens which allows you to choose a location on
your computer where you want to save the file.
4. Click “Save”.
5. The browser window closes.
6. A progress bar in the bottom of the File Share component gives
you feedback on the progress of the download.
7. When the download is completed the file is saved on your
computer in the location you selected.
Opening a file in the Content Viewer
If a file is supported by the Content Viewer an “Open” button appears when
a file is selected .swf, .jpg, .gif, .jpg formats are supported by the Content
Viewer Component. Microsoft Office documents (.ppt, .xls, .doc) can be
uploaded and converted within SAFARI Montage® Live!
1. Select the File you want to open by clicking on it.
2. Click the “Open” button. The button is not visible if you cannot
load the selected content into the Content Viewer, you may need
to convert it first by clicking the “Convert” button.
3. The file opens in the Content Viewer.
Converting a file
Microsoft Office documents (.ppt, .xls, .doc) can be uploaded and
converted within SAFARI Montage® Live!
1. Select the File you want to convert by clicking on it.
2. Click the “Convert” button. The button is not visible if you cannot
convert the selected content using SAFARI Montage® Live!. You
may be able to convert the file using an application such as Adobe
FlashPaper.
3. Icons will inform you of the state of your file as it is queued for
conversion, loaded into the conversion server, converted and then
returned to your session. Depending on bandwidth, file size and
amount of files being converted this usually takes a few minutes.
You can start a conversion by going through the steps described above and
leave the room to return at a later point in time if you do not want to wait
or prepare content before a meeting has started.
You can also download converted content to your computer and upload it
to another session for further use.
NOTE: Converting files requires your SAFARI Montage® Live! server to be
enabled with an SAFARI Montage® Live! Document Converter – if the
“Convert” button does not appear when selecting supported documents
your installation is not enabled. Please contact your system administrator.
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CHAPTER 8
THE SCREEN SHARING COMPONENT
Next to sharing and presenting files, sharing your screen content is one of the most
popular and important forms of online information broadcast. The Screen Sharing
component allows you to send and receive your and other participants’ screens.
The Screen Sharing broadcast and compression codec is highly optimized to screen
broadcasts. Still, Screen Sharing is a very bandwidth intensive activity. For this
reason any Video broadcasts are automatically switched to Audio mode when any
Screen Sharing activity is initiated.
Viewers of a Screen Sharing broadcast need no additional downloads or installations
to watch a broadcaster’s screen. Broadcasters need to install a small driver. SAFARI
Montage® Live! will prompt you to install this driver if you attempt to share your
screen and do not have it installed.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types
have different access levels to this component. The following table summarizes
the differences:

Share your Screen
Download driver
Local Feedback on / off
Receive a Screen Share broadcast

Account
Holder
9
9
9
9

Moderator

Participant

Observer

9
9
9
9

9

9

Installing the Driver
Before you can start sharing your screen you must install the SAFARI Montage®
screen sharing driver. You need to do this only once on any computer. Once
you have installed this driver, it will always be ready for you to use.
Please follow the instructions for your operating system and internet browser
below. Sorry, Linux is not supported at this time.

Windows PC - Installing the driver with Internet Explorer®
SAFARI Montage® Live! will recognize that you do not have the driver
installed and guide you through the installation process. This process may
vary slightly depending on which browser you are using.
1. Click the “Start Share” button.
2. An alert window will open notifying you of the missing driver and
asking you whether you want to install it.
3. Click “Yes”.
4. The File Download – Security Warning window will open asking you
whether you want to run or save this file.
5. Click “Run”.
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6. An Internet Explorer – Security Warning window will open notifying
you that the publisher could not be verified and details of the file
you are about to install.
7. Click “Run”.
8. The SAFARI Montage® Live! Screen Capture Driver Setup Wizard
will open.
9. Click “Next”.
10. You will be prompted to select a location for the installation. The
field is prefilled. We recommend you do NOT change the default
location.
c:\Program Files\SAFARI Montage® Live! \Screen Capture
(This path may vary depending on the language of your Operating
System)
11. Click “Next”.
12. You will be prompted to select your start menu folder. The field is
prefilled. We recommend you do NOT change the default location.
SAFARI Montage® Live! \Screen Capture
13. Click “Next”.
14. The Ready to install screen shows you where your screen sharing
driver will be installed.
15. Click “Install”.
16. The installation will run and you are presented with a screen that
confirms successful installation.
17. Click “Finish”.
18. The set up wizard will close.
19. Close all windows of your browser and re-enter the SAFARI
Montage® Live! session.
You are now ready to share your screen. Click “Start share” to start sharing
your screen. Find more information below in the section "Sharing your Screen."
Windows PC - Installing the driver with Mozilla Firefox®
SAFARI Montage® Live! will recognize that you do not have the driver
installed and guide you through the installation process. This process may
vary slightly depending on which browser you are using.
1. Click the “Start share” button.
2. An alert window will open notifying you of the missing driver and
asking you whether you want to install it.
3. Click “Yes”.
4. A File Download window will open asking you whether you want to
save this file
5. Click “OK”.
6. The file gets downloaded to your download folder.
7. Locate the installer and double click it to run the installer.
8. The SAFARI Montage® Live! Screen Capture Driver Setup Wizard
will open.
9. Click “Next”.
10. You will be prompted to select a location for the installation. The
field is prefilled. We recommend you do NOT change the default
location.
c:\Program Files\SAFARI Montage® Live! \Screen Capture
(This path may vary depending on the language of your Operating
System)
11. Click “Next”.

SAFARI Montage® Live! User Manual for Account Holders and Moderators

Revision 2
40 / 61

C5422 Feb. 2009

12. You will be prompted to select your start menu folder. The field is
prefilled. We recommend you do NOT change the default location.
SAFARI Montage® Live! \Screen Capture
13. Click “Next”.
14. The Ready to install screen shows you where your screen sharing
driver will be installed.
15. Click “Install”.
16. The installation will run and you are presented with a screen that
confirms successful installation.
17. Click “Finish”.
18. The set up wizard will close.
19. Close all windows of your browser, then re-enter the session.
You are now ready to share your screen. Click “Start share” to start sharing
your screen. Find more information below in the section "Sharing your Screen."
Windows PC - Uninstalling the driver
If at any time you should choose to uninstall the SAFARI Montage® Live!
screen sharing driver you can do so in a few easy steps.
1. Click the “Start” button in your windows operating system.
2. Navigate to All Programs > SAFARI Montage® Live! > Screen
Capture > Uninstall.
3. A window will pop up asking you whether you are sure you want
to uninstall.
4. Click “Yes”.
Depending on what applications you are running at the time you may
receive a message stating that not all elements of the application could be
removed. Assuming you haven’t changed the install location, navigate to
My Computer > Program Files > SAFARI Montage® Live!
Mac OS X - Installing the driver with Safari®
SAFARI Montage® Live! will recognize that you do not have the driver
installed and guide you through the installation process. This process may
vary slightly depending on which browser you are using.
1. Click the “Start Share” button.
2. An alert window will open notifying you of the missing driver and
asking you whether you want to install it.
3. Click “Yes”.
4. Safari will download the application to your download folder.
5. When alerted that “Install SAFARI Montage® Live! Screen Capture
Driver.app” is an application, click “Download”.
6. Locate “Install SAFARI Montage® Live! Screen Capture Driver” on
your computer and double click it to run it.
7. The installer launches, click “Install” in the application window.
8. Read and accept the license terms by clicking “Accept”. Decline if
you do not agree with the terms and want to abort installation.
9. Enter your administrator password.
10. Wait for the message to appear that the driver has been installed.
11. Click OK.
12. Quit your browser and re-enter your SAFARI Montage® Live!
session.
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You are now ready to share your screen. Click “Start share” to start sharing
your screen. Find more information below in the section "Sharing your Screen."

Mac OS X - Installing the driver with Firefox®
SAFARI Montage® Live! will recognize that you do not have the driver
installed and guide you through the installation process. This process may
vary slightly depending on which browser you are using.
1. Click the “Start Share” button.
2. An alert window will open notifying you of the missing driver and
asking you whether you want to install it.
3. Click “Yes”.
4. By default Firefox will ask you what to do with the file you are
trying to download, choose the “Save to disk” radio button and
click ok.
5. Choose the location where you want to save the file and click Save.
Do not change the file name.
6. Locate the file and double click it to unzip the file and wait for the
process to complete.
7. Locate the “Install SAFARI Montage® Live! Screen Capture Driver
v1.0” folder and open it.
8. Locate “Install SAFARI Montage® Live! Screen Capture Driver” and
double click it to run it.
9. The installer launches, click “Install” in the application window.
10. Read and accept the license terms by clicking “Accept”. Decline if
you do not agree with the terms and want to abort installation.
11. Enter your administrator password.
12. Wait for the message to appear that the driver has been installed.
13. Click OK.
14. Quit your browser and re-enter your SAFARI Montage® Live!
session.
You are now ready to share your screen. Click “Start share” to start sharing
your screen. Find more information below in the section "Sharing your Screen."
Mac OS X - Uninstalling the driver
If at any time you should choose to uninstall the SAFARI Montage® Live!
screen sharing driver you can do so in a few easy steps.
1. Locate the “Install SAFARI Montage® Live! Screen Capture Driver”
application on your computer and launch it.
2. Select “Uninstall”.
3. Enter your administrator password.
4. Wait for the message to appear that the driver has been
uninstalled.
5. Click OK.
You should restart all applications that were using the driver.

Sharing your Screen
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Provided you have installed the screen sharing driver, you can start
broadcasting your screen to a global audience at the click of a button.
Starting to Screen Share
Make sure the Screen Sharing component is visible on stage. If it is not,
make it visible using the Workspace menu in the title bar. More information
is available in the section on Modifying your Workspace.
You can start screen sharing at any time, even when someone else is
sharing their screen. You will simply take over the broadcast. Only one
person can broadcast their screen at any one time.
1. Click the “Start Share” button.
2. A message appears next to the button confirming you are sharing
your screen.
3. If Video is being broadcast in the Audio / Video Component,
broadcasts will be switched to Audio to save bandwidth.
NOTE: You will not see your own screen share to save processing power.
You can however turn it on to see local feedback on what other users are
seeing.
Turning on Local Feedback
This feature allows you to see your own screen sharing activity. You should
not turn this on consistently to save processing power and ultimately
achieve better performance.
1. Click on the cogwheel icon in the Screen Share component to
expand the context sensitive menu.
2. Select “Local Feedback” (only visible while sharing your screen).
3. You will see your own screen share.
NOTE: Most likely what you will see is a repeating mirrored image of the
SAFARI Montage® Live! interface. You are sharing your entire screen,
1024px width and 768px height starting from the top left corner of your
main screen. To show another application or your desktop, simply
minimize SAFARI Montage® Live! to the task bar or move the window to
another screen.
Turning off Local Feedback
Once you have previewed your own screen share you can turn local
feedback off again.
1. Click on the cogwheel icon in the Screen Share component to
expand the context sensitive menu.
2. Select “Local Feedback” (only visible while sharing your screen).
3. You will stop seeing your own screen share.
Changing your bandwidth / quality settings
You can adjust the quality of the image you send to other users. If you are
facing limited bandwidth you may want to adjust this setting downwards,
alternatively if you need high quality images you may want to adjust this
setting upwards. As a rule of thumb, higher quality means higher latency.
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1. Click on the cogwheel icon in the Screen Share component to
expand the context sensitive menu.
2. Select “High bandwidth”, “Medium bandwidth” or “Low bandwidth”
(only visible while sharing your screen) to select the desired
setting.
3. You will now share your screen at the selected quality setting.
Stopping Screen Share
When you are finished broadcasting your screen you should stop sharing
and allocate bandwidth to video and audio communications.
1. Click the “Stop Share” button.
2. The broadcast will end.
Viewing Screen Share
When a user shares his screen you will be able to see his broadcast in the
screen share window, with a message below telling you who is sharing their
screen.
By default you will see the screen at the full resolution it is broadcast at. If
it this does not fit into your browser screen share window, scroll bars will
appear to allow you to move the image around.
You can click the “fit to screen / 100%” toggle button in the bottom left
hand corner of the screen share window. This will resize the broadcast
image to fit into the available viewing area. Click the button again to switch
back to 100% view. This button does not affect other users.
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CHAPTER 9
THE URL PUSH COMPONENT
One of the most shared resources in collaborative environments are websites or links
to resources on the web. Similar to a street address, on the web such resources are
identified by Universal Resource Locators (URL).
The URL Push Component makes it easy to create a list of such resources and even
actively “push” this content to your connected users.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types
have different access levels to this component. The following table summarizes
the differences:

Add URL
Remove URL
Push URL (co-browse)
Visit URL

Account
Holder
9
9
9
9

Moderator

Participant

9
9
9
9

9

Observer

Managing your URLs
You can create a list of URLs in either before a session or add them to the list
as the need arises. As soon as you add a URL to the list it will become visible to
all users in the session. The URLs remain in the list until you remove them,
even if you leave the room and come back later.
Adding a URL
When you enter a new conference the URL Push component will be empty.
Add URLs to the list to share them with the group.
1. Either type or copy / paste a URL into the URL Push component’s
text field.
2. Click “Add”.
3. The URL will appear in the list. All users can see it.
NOTE: URLs typically begin with “http://”. The text field is pre-filled with
this value. If you copy / paste a URL into the field make sure you do not
enter that value twice (“http://http://”) as this will make the URL incorrect.
Removing a URL
You can remove URLs from the list at any time.
1. Click on the URL you want to remove from the list.
2. In the drop down menu below the list, select “Remove” by clicking
on it.
3. Click the  button.
4. The URL will be removed from the list.
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NOTE: URLs typically begin with “http://”. The text field is pre-filled with
this value. If you copy / paste a URL into the field make sure you do not
enter that value twice (“http://http://”) as this will make the URL invalid and
prohibit your browser from finding it.
Visiting a URL
If you visit a URL a new browser window will open to view the resource.
This will only happen on your own screen.
1. Click on the URL you want to view from the list.
2. In the drop down menu below the list, select “Visit” by clicking on
it.
3. Click the  button.
4. A new browser window will open, directing you to the resource.
NOTE: If you have any pop-up blockers installed they must be disabled for
this feature to work.
Pushing a URL (Co-browsing)
You can proactively open URLs on the screens of all users connected to the
room. This will open a new browser window on their screens and direct
them to the resource.
1. Click on the URL you want to push from the list.
2. In the drop down menu below the list, select “Co-browse” by
clicking on it.
3. Click the  button.
4. A new browser window will open on all users’ screens, including
your own, directing everyone to the resource.
NOTE: Pop-up blockers installed must be disabled for this feature to work.
Each user must do this on their own computer.
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CHAPTER 10
THE CHAT COMPONENT
Chat is an unobtrusive means of communications during any online meeting or
presentation. Large or small groups of users can communicate amongst each other
without interrupting any video or audio broadcasts or causing additional bandwidth
overhead.
The Chat component also doubles as a meeting transcript, automatically keeping
track of when users enter and leave the meeting and transcribing this info in
chronological order.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types
have different access levels to this component. The following table summarizes
the differences:

Send Chat Messages
Save the transcript
Clear Chat Messages

Account
Holder
9
9
9

Moderator

Participant

Observer

9
9
9

9
9

9
9

Working with Chat
One of the great advantages of chat communication is its persistent nature.
Messages typed into the chat remain visible so users who join a session late or
need to temporarily divert their attention to other tasks can look back through
the content to see what they have missed. Similarly, a presenter can allow
users to ask questions via the chat component and answer them at the end of
the presentation, scrolling through the transcript at his own convenience.
Another popular method is to have a co-presenter monitor chat activity and
answer questions in writing while the presentation continues uninterrupted.
Several levels of communication can co-exist in the same SAFARI Montage®
Live! session. Finally, chat transcripts can be saved as a text file for reference
and archiving.
Typing a chat message
Chat messages can be entered at any time.
1. Type the message you want to appear into the text field at the
bottom of the Chat component.
2. Either press the Return key on your keyboard or click the 
button.
3. The message will appear in the chat component, chronologically
sorted underneath the previous message.
Each user’s messages are clearly identified by his or her name and a
semicolon in front of their message.
Clearing the chat transcript
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Account Holders and Moderators can clear the chat transcript at any time.
In meetings with large user numbers and a lot of chat activity it is
recommended to do this periodically for better performance.
1. Click on the cogwheel icon in the Chat component to expand the
context sensitive menu.
2. Select “Clear chat history” from the menu.
3. The chat will be cleared.
NOTE: Once the chat transcript is cleared it cannot be recovered. Make sure
you save it if you want to store it.
Saving the chat transcript
You can save the transcript to a file on your computer at any time.
1. Click on the cogwheel icon in the Chat component to expand the
context sensitive menu.
2. Select “Save the Transcript” from the menu.
3. A message appears in the chat (only visible to you) stating, “The
transcript has been saved to the following url:” followed by a link.
4. Click on the link.
5. A browser window will open containing the contents of the chat
window.
6. Save the file to a location on your computer.
7. Close the window to return to SAFARI Montage® Live!
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CHAPTER 11
THE POLLING COMPONENT
Polling is a welcome alternative to any online meeting or training session. It is a
visual means of allowing users to give feedback to topics and adds variety and
richness to your online conferences.
Questions are multiple choice and answers can be presented as both bar- and pie
charts.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types
have different access levels to this component. The following table summarizes
the differences:

Create Polls
Answer Questions

Account
Holder
9
9

Moderator

Participant

Observer

9
9

9

9

Working with Polling
The account holder or a moderator generally creates polls before making them
available to all users to answer in real time. Polls can and must be created onthe-fly at any time in a live session.
The polling module has three states.
1. Preparation, while someone is preparing a poll.
2. Live, while a poll is being conducted and users can answer questions.
3. Closed, while no-one is preparing a poll.
Preparing a Poll
If the polling module is not visible, make it visible via the workspace >
Show Components menu. If someone else is currently preparing a poll you
will see a message similar to “[Username] is preparing a poll”. You can take
over control by clicking the “end poll” button.
1. Click the prepare button.
2. Click the “add a question” ( ) button to add a question.
3. Enter your question in the text field that appears in the polling
module.
4. Click the “add an answer” ( ) button to add an answer. You can
add as many answers as you like by repeatedly clicking this
button.
5. Enter the text for each answer in the corresponding text field.
6. Choose a color for each answer by clicking the color selection field
next to each answer’s text field. This color will represent this
question in the results pie / bar chart when you publish your poll.
7. Repeat steps 2-6 for as many questions as you like. Use the red
“x” button to delete questions or answers.
8. Click “Go Live” to make your poll visible to everyone in the room.
Alternatively click “End Poll” if you don’t want to show your poll to
others.
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You can use the blue arrows to navigate between questions. Use the drop
down menu to quickly navigate to a certain question.
Controlling a Live Poll
Any account holder or moderator in the room can control a live poll,
regardless of whether you yourself have prepared it or not.
You can use the blue arrows to navigate between questions. Use the drop
down menu to quickly navigate to a certain question.
Any question can be displayed as a pie chart or as a bar chart. Simply click
the pie chart or bar chart buttons to switch between the views. All users
will now see the new view.
To answer a question, simply click the radio button next to the answer you
want to select. You can change the answer to a question after you have
selected an answer.
Closing a Poll
When you want to end a poll simply click the “End Poll” button. Users will
no longer be able to see the pall or answer questions.
You can also go straight back into preparation mode to edit an already
created poll by clicking the “Prepare Poll” button.
Polling experience for participants and observers
Participants and observers see a simplified view of the polling module.
They do not see the “Prepare”, “Go Live” or “End Poll” buttons. They can see
a message when nobody is preparing a poll or when a certain user is
preparing a poll.
When a poll goes live they are presented with the current question title and
the possible answers. They can also see how many people responded to the
question and the percentage of people in the room who chose a particular
answer to a question. They cannot move to other questions, account
holders and moderators control the experience and pace.
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CHAPTER 12
RECORDING
Recording is the link between synchronous and asynchronous communication. You
can use it to create a presentation on your own and publish it on the web with very
little effort or you can record an entire online collaboration session for later
reference or for transcription by your secretary. By recording presentations no
information is lost, and communications that used to perish now become
sustainable. The learning value for any organization is immense.

Meeting roles and component restrictions
To ensure ordered communication in large user groups, different user types
have different access levels to this component. The following table summarizes
the differences:

Start Recording
Stop Recording
Access Recording URL
Edit Recording Information

Account
Holder
9
9
9
9

Moderator

Participant

Observer

9
9

Recording your sessions
There are some important rules to remember:
• Any Account Holder or Moderator can start a recording.
• Only one recording can be made at any one time.
• Any Account Holder or Moderator can stop the recording.
• If the person who started the recording exits the room, the
recording is stopped and archived.
When starting a recording you are prompted to enter a name. This name is
similar to the session name in that it appears in the title of the browser window
when watching a recording and is used to identify the recording in your
account center. Check the sections on Viewing and Editing Recordings for more
info.
Starting a Recording
Each recording is an independent entity. Once completed a recording is
automatically archived and associated with an independent URL.
1. Click the “Record” button in the Title Bar.
2. A window will appear prompting you to enter a name for the
recording.
3. Enter a name in the text field.
4. Click “Start” or click “Cancel” to cancel.
5. The window closes and the recording begins.
A message in the title bar notifies you that you are recording. All connected
users can see a similar message notifying them that you are recording the
session. All Moderators can also see a “Stop” button.
Stopping a Recording
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Account Holders and Moderators can all stop a recording.
1. Click the “Stop” button in the Title Bar.
2. The recording is stopped and archived immediately.
NOTE: If the person who started the recording leaves the session the
meeting is automatically stopped.
Pressing the record button again will start a new recording. A recording
cannot be resumed.
Viewing a Recording
Recordings are managed through the Account Center. This means only the
Account Holder can give access to the recorded sessions.
Each recording is identified by a unique URL. Account Holders can send this
link out via email, instant messenger programs or publish it on the web,
thereby giving people access from outside the Account Center.
Please refer to the appropriate section in the chapter on the Account Center
for detailed information.
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CHAPTER 13
RIGHTS MANAGEMENT
Control is everything in online meetings. SAFARI Montage® Live! features a
sophisticated user control system second to none. 4 user types exist in session, each
with a different predefined set of access rights to each module, optimized for
standard use cases.
SAFARI Montage® Live! takes it one step further. Each user type is completely
dynamic. This means you can modify the way rights management behaves and what
each user is allowed to do at any time in real time.
You have complete control:
•
•
•
•

Promote and demote individual users to higher or lower user types.
Give an individual user particular rights to a particular component.
Configure what access rights each user type allows on a component per
component basis.
Configure what access rights user types have for the entire group.

Meeting roles and component restrictions
Each component has its own preconfigured set of rights per user type. Please
refer to the chapter of each component to understand which features are
presented to each user.
Functionality is usually hidden from users who are not allowed to use it. For
example, an observer will not see a “delete file” menu item or an “add file”
button, whereas a moderator will.
This has two advantages:
•
•

Users can be denied access to certain functionality.
Users who do not need buttons are presented with a simpler, less
cluttered interface. This makes use of the system easier and adoption
faster.

Rights Management itself is also governed by access by user type.

Change particular user rights
Change user type permissions of
all user types
Change user type permissions of
participants and observers only

Account
Holder
9

Moderator

Participant

Observer

9

9
9

Working with Rights Management
We can distinguish between two types of interaction: Changing access rights
for an individual user or changing access rights for a group of users.
Rights management can be utilized whenever the need arises. There is no need
to decide pre-session who will be allowed to do what. Since online meetings
are dynamic environments it is important to be ready to react to any situation.
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The only restriction to Rights Management is that each session can only have
one Account Holder. This is typically the user who has called the meeting.
Promoting or demoting a user
You can choose to elevate or reduce the ability of a user to interact at any
time.
1. Locate the Participant List component. If it is not visible in the
workspace, make it visible through the workspace menu.
2. Click on the user whom you want to promote or demote.
3. In the title bar, click the “Rights Management” menu.
4. Select “Selected User” > “Change Status” > The user type you want
to change a user to.
NOTE: If the “Selected User” menu is grayed out you have selected
yourself in the Participant List or not selected a user.
5. The icon of that user in the Participant List will change to
represent his new user type. Depending on how many users are
connected and state of your network connection this may take a
few seconds.
6. The users interface will update in accordance to his new set of
rights.
Changing a user’s access rights to a particular module
Sometimes you may want to allow a single user access to a single
component only. For example, you may want to allow a user to speak to
the group but don’t want him to be able to erase files. SAFARI Montage®
Live! makes this possible thanks to absolute granularity of access rights
management.
1. Locate the Participant List component. If it is not visible in the
workspace, make it visible through the workspace menu.
2. Click on the user whom you want to promote or demote.
3. In the title bar, click the “Rights Management” menu. Select
“Selected User”.
NOTE: If the “Selected User” menu is grayed out you have selected
yourself in the Participant Lost or not selected a user.
4. In the submenu, find the component to which you want to allow or
disallow access.
5. Another submenu opens, you can set a particular users access
rights to a higher or lower level than his current user type
currently permits by clicking that particular level.
6. Since his base user type has not changed, the user’s icon will not
change in the Participant List.
7. The users interface will update in accordance to his new set of
rights.
NOTE: To check what rights a particular user has, select him in the
Participant List, click on the Rights Management menu in the Title Bar and
hover over “Selected User”. Each component has a user type icon next to it
representing the access rights to each.
Changing a user type’s access rights to a particular module
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In certain occasions you will want all of your users of a certain type to be
able to do something. Rather than having to change each user one by one
you can change the access rights set of that particular user group. An
example is you want all of the participants in the meeting to be able to
upload their files to the meeting. The Participant user type, by default, is
not allowed to do this. So you can modify this setting directly in session.
1. In the Title Bar, click the “Rights Management” menu.
2. Find the user type whose rights you want to modify.
NOTE: The user type “Account Holder” cannot be modified.
3. Find the component whose access rights you want to modify.
4. Select the user level you want that user type to be promoted or
demoted to.
5. All users of that user type in the session will see the changes on
their screen. New users of that user type who join session will also
receive the new modified rights scheme.
6. The users interface will update in accordance to his new set of
rights.
NOTE: Moderators can only set group permissions for the user types
Participant and Observer. They cannot set group permissions for their own
group.
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Rights by User Type: Overview
The following table gives a complete overview of what each user type is or
isn’t allowed to do.
Account
Holder
SYSTEM WIDE RULES
Account settings
Top-Up Credit
Promote Users to Moderator
Screen Layouts
Show / Hide Modules
Invite Users
Kick / Ban Users
AUDIO / VIDEO
Set Broadcast Type (Audio, Picture,
Video)
Set Video Shape & Size
Upload Image
Zoom Level
Stop Other Broadcasts
Start broadcast without permission
Start broadcast with permission
Push-to-talk / Hands-free mode
Stop your broadcast
Pause your video broadcast
Mute your audio broadcast
Pause others video
Mute others audio
PARTICIPANT LIST
See who is connected
See how many people are
connected
See user types
Change my name
Remove User
CONTENT VIEWER
Load content
Clear content
Show / Hide whiteboard
Control Content
Work Alone / Follow Others
FILE SHARING
Add Files
Delete Files
Delete All Files
Open Files
Cancel an upload
Save Files
SCREEN SHARING
Share your Screen
Download driver
Local Feedback on / off
Receive a Screen Share broadcast
URL PUSH
Add URL
Remove URL
Push URL (co-browse)
Visit URL
CHAT
Send Chat Messages
Save the transcript
Clear Chat Messages
POLLING
Create Polls
Answer Questions
RECORDING
Start Recording

Moderator

Participant

Observer

9
9

9
9

9
9
9
9
9
9
9

9
9
9
9

9

9

9
9
9
9
9

9
9
9
9
9

9
9
9
9
9
9

9
9
9
9
9
9

9
9
9
9
9
9
9

9

9

9

9

9

9

9

9

9
9
9

9
9
9

9
9

9
9

9
9
9
9
9

9
9
9
9
9

9
9
9
9

9
9
9
9

9
9
9
9
9
9

9
9
9
9
9
9

9

9
9
9
9

9
9
9
9

9

9
9
9
9

9
9
9
9

9

9
9
9

9
9
9

9
9

9
9

9

9

9

9
9

9
9

9

9
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Stop Recording
Access Recording URL
Edit Recording Information
RIGHTS MANAGEMENT
Change particular user rights
Change user type permissions of
all user types
Change user type permissions of
participants and observers only

9
9
9

9

9

9

9
9

SAFARI Montage® Live! User Manual for Account Holders and Moderators

Revision 2
57 / 61

C5422 Feb. 2009

INDEX
.bat, 45
.exe, 45
.gif, 10, 31, 38, 42, 43, 45, 48
.jpg, 10, 31, 38, 42, 43, 45, 48
.png, 10, 31, 42, 43, 45
.swf, 10, 38, 42, 48
Accepting a request to speak, 34
Access, 11, 21, 28, 33, 65, 72
access levels, 25, 35, 38, 45, 49,
57, 60, 62, 65
Account Center, 12, 14, 15, 16,
17, 66
Account Holder, 19, 20, 25, 29,
35, 38, 45, 49, 57, 60, 62,
65, 66, 67, 68, 69, 71
account holders, 9
Account Holders, 23, 33, 39, 40,
61, 66
Add, 12, 19, 45, 46, 57, 71, 72
add a question, 62
add an answer, 63
add and remove components, 24
add file, 67
Adding a file, 46
Adding a URL, 57
Adobe Flash Player®, 26
Adobe Flash®, 9, 10, 11, 42, 43,
45
Adobe FlashPaper®, 10, 38, 42,
43, 45
Adobe® Flash Media Encoder (FME),
32
answer a question, 63
asynchronous communication, 65
audience, 10, 24, 25, 26, 31, 54
audiences, 9, 15, 25
audio, 9, 10, 11, 19, 24, 25,
26, 27, 28, 29, 30, 31, 55,
60
Audio / Video component, 13, 28,
30, 31, 32
Audio / Video Component, 19, 25,
33, 34, 54
Audio /Video, 21
Audio and Video component, 28, 29
Audio and Video on the Internet, 25
automatically resize, 43
Ban Permanently, 22, 36
bandwidth, 24, 25, 26, 29, 30,
31, 32, 46, 49, 54, 55, 60
Bandwidth, 25
bar chart, 63
Broadcast Modes, 30
broadcast your screen, 19, 28
browser, 9, 11, 27, 31, 46, 47,
50, 51, 52, 53, 58, 61, 65
camera, 9, 27, 28, 29, 30
Camera, 21, 27
Cancel all uploads, 47

Cancel this upload, 47
Change my name, 35, 36, 71
Change Status, 21, 68
Changing a user type’s access
rights, 69
Changing a user’s access rights, 68
Changing a User’s Status, 36
Changing the password, 16
Changing User Names, 35
chat, 10, 19, 60, 61
Chat, 19, 21, 24, 60, 61, 72
Clear ghost users, 21
Clearing the chat transcript, 61
Co-browse, 58
cogwheel icon, 12, 22, 30, 31,
32, 36, 40, 46, 47, 54, 55,
61
collapse, 22
color, 63
communication experience, 10
component restrictions, 25, 35,
38, 45, 49, 57, 60, 62, 65,
67
components, 18
compression algorithms, 26
compression technology, 25
Configuring your Audio and Video,
27
Connect, 10
connected users, 23, 57, 66
connection status, 21
Connection Status, 22
Content Types, 42
Content Viewer, 19, 21, 24, 38,
39, 40, 42, 43, 45, 46, 47,
48
context sensitive menu, 22, 23,
30, 31, 32, 36, 40, 46, 47,
54, 55, 61
Copy Session link to clipboard, 12
Corporate firewalls, 26
crossed through, 29, 30
custom layout, 24
Custom Layouts, 24
Custom View, 21, 24
Delete, 45, 47, 71
delete file, 67
delete key, 42
Deleting a file, 47
Deleting all files in a room, 47
delivery medium, 26
demote, 68, 69
Demote, 67
Denying a request to speak, 34
different user types, 25, 33, 35,
38, 45, 49, 57, 60, 62, 65
disconnected, 22, 36
Discussion View, 21, 24
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Distributing a recording, 17
download, 9, 10, 47
downloading, 46, 47
downloads, 9, 49, 51
DS Screen, 28, 50, 51
Duration, 15
edit, 14, 16
Editing a recording, 16
Editing a session, 16
email, 9, 11, 12, 14, 15, 16,
17, 35, 66
email invitation, 12, 16
encoding, 26
Eraser, 42
External Video Source, 32
feedback, 10, 21, 27, 38, 46,
47, 54, 55
Feedback, 10, 49, 54, 55, 72
File Share, 12, 13, 19, 38, 39,
45, 46, 47
File Share component, 13
file types, 9, 42
Fileshare, 21
firewall, 11, 26
Firewalls, 26
Flash Player 8, 31, 46
Follow others, 39
Freehand, 41
functionality, 11, 12, 22, 23, 35,
43, 67
generate password, 15
Getting Started, 12
Giving users access, 34
GMT, 15
green light, 22
H.264, 32
hands-free, 29
Hardware, 26
headset, 11, 27
headsets, 26
hide and show components, 22, 23
Hiding the Whiteboard, 40
high fidelity image, 26
http://, 58
identify users, 35
image, 12, 30, 31, 32, 42, 43,
45, 54
Image Files, 43, 45
install, 9, 49, 50, 51, 52, 53
installations, 9, 49
Installing the Driver, 49
instant messenger, 9, 12, 14, 17,
66
integrate, 9
Internet, 11, 25, 26, 27, 50
Internet connection, 11, 27
Internet Explorer®, 50, 52, 53
invite users, 12
Invitees, 19
Kick a User, 36

landscape, 31
Landscape, 32
large, 9, 24, 25, 31, 35, 38,
45, 49, 57, 60, 61, 62, 65
layout, 11, 22, 23, 24, 31
learning, 9, 65
Line, 41
link, 9, 12, 14, 17, 21, 61, 65,
66
list of users, 34
LMS software, 9
Loading a File, 38
Local Feedback, 54, 55
lock icon, 28
Managing files, 46
manual configuration, 27
Manual Configuration, 27
Marking Up Content, 40
medium, 25, 26, 31
Meeting roles, 25, 35, 38, 45,
49, 57, 60, 62, 65, 67
Meeting Roles, 19
meeting room, 9, 10, 16, 45, 46,
47
microphone, 11, 27, 28, 29, 30
Microphone, 21, 28
microphones, 26
Microsoft Office®, 9, 45
Microsoft PowerPoint®, 10
minimum requirements, 26
missing driver, 50, 51, 52, 53
moderator, 9, 67
Moderator, 19, 20, 21, 22, 25,
29, 35, 38, 45, 49, 57, 60,
62, 65, 67, 71
Moderators, 23, 31, 33, 34, 39,
40, 61, 66, 70
Modifying your workspace, 23
move, 22
Moving Elements, 42
Mozilla Firefox®, 51
Msg, 15
multimedia, 10, 11
multiple choice, 62
multiple-choice, 10
Mute others audio, 25, 71
Mute your audio broadcast, 25, 71
Muting your Audio, 29
network, 26, 32, 68
number of connected users, 36
Observer, 19, 20, 21, 22, 25,
35, 38, 45, 49, 57, 60, 62,
65, 67, 70, 71
On2 VP6, 32
online collaboration, 10, 65
online meeting, 9, 10, 60
online meetings, 9, 26, 67, 68
Online meetings, 9
Online Meetings, 9
Open, 13, 39, 45, 48, 71
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Opening a file, 47, 48
Options, 12, 21
or Adobe FlashPaper®, 12
ordered communication, 25, 35,
38, 45, 49, 57, 60, 62, 65
Oval, 42
paging, 43
Participant, 19, 20, 21, 22, 25,
35, 36, 37, 38, 45, 49, 57,
60, 62, 65, 67, 68, 69, 70,
71
participants, 9, 10, 11, 15, 45,
49, 68, 69, 72
Participants, 10, 21, 24, 33, 34
password, 15, 16
Pause others video, 25, 71
Pause your video broadcast, 25, 71
Pausing your Video, 29
performance, 26, 54, 61
Permanently Ban a User, 36
pie chart, 63
poll, 10
Polling, 19, 62
portrait, 31
Portrait, 32
Predefined Layouts, 24
preparation mode, 23
Preparation Mode, 23
Preparation View, 21
Presentation View, 21, 24
presentations, 9, 10, 19, 25, 43,
65
presenting content, 12
Promote, 20, 67, 71
Promoting or demoting a user, 68
Pushing a URL, 58
Push-to-talk, 29
Pwd, 15
quality, 25, 26
quality of your broadcasts., 26
questionnaires, 10, 19
Quick Start, 11, 12, 14
Quick Start a Session, 12, 14
real time, 9, 10, 25, 67
Reconnect, 22
Record, 10, 66
recording, 16, 17, 65, 66
Recording, 65, 72
Recording your sessions, 65
Rectangle, 42
red light, 22
reduced options, 23
remember, 15, 65
Remember Checkbox, 28
Remove, 35, 36, 57, 58, 71, 72
Removing a URL, 58
Removing a User, 36
resize, 22
resize handle, 22
results, 10

Rights Management, 21, 34, 36,
37, 40, 67, 68, 69
role, 19, 35
rules, 20, 65
Save, 21, 45, 47, 60, 61, 71,
72
Save Current as Custom, 21
Saving the chat transcript, 61
schedule, 9, 12, 14, 41
Schedule a Conference, 14
schedule a session, 12
Schedule a session, 15
schedule meetings, 9
scheduling, 11
Screen Capture, 50, 51, 52
screen layouts, 9
Screen Share, 21, 24, 49, 54, 55,
72
Screen Share View, 21, 24
Screen Sharing, 19, 49, 54
screen sharing driver, 28, 49, 50,
51, 52, 53, 54
scrolling, 43, 60
search, 43
Selected User, 21, 36, 37, 68, 69
Selector, 41
Send Email invitation, 15
send out email invitations, 9, 11,
14, 15
send video, 25, 27
Sending Audio and Video, 28
session, 10, 12, 14, 15, 16, 17,
36, 39, 57, 60, 65, 66, 67,
68, 69, 70
Set Broadcast Type, 25, 71
Set Video Shape & Size, 25, 71
Setting Shape & Size, 31
Setting up, 9, 14
Settings, 21, 27, 28, 29
Set-up Wizard, 27
shape & size, 25
shape and size, 31, 32
Sharing Content, 38
sharing your screen, 24, 49, 50,
51, 52, 53, 54
Sharing your Screen, 50, 51, 52,
53, 54
show components, 22, 23
Show Components, 21, 24
Showing the Whiteboard, 40
small, 31, 49, 60
software, 10, 11, 27
Software, 26
speaker system, 11
Stamp, 41
Start, 11, 13, 15, 19, 28, 34,
50, 51, 52, 53, 65, 66, 72
Start Broadcast, 13, 28, 34
Start broadcast with permission, 25,
71
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Start broadcast without permission,
25, 71
Start Share, 54
Starting a Recording, 65
Starting your Broadcast, 28
Stop, 25, 29, 30, 55, 65, 66,
71, 72
Stop Broadcast, 29
Stop Other Broadcasts, 25, 30, 71
Stop other users’ Broadcasts, 30
Stop receiving another person’s
Audio, 30
Stop receiving another user’s Video,
30
Stop Share, 55
Stop your broadcast, 25, 71
Stopping a Recording, 66
Stopping Screen Share, 55
Stopping your Broadcast, 29
Supported File Types, 45
switch between predefined layouts,
24
Switching between broadcast
modes, 30
synchronous communication, 65
system administrator, 45
system administrators, 26
system check, 27
System Check, 27
system requirements, 11
System Requirements, 11
system specifications, 27
Talk button, 28
test your system, 27
Text, 41
The Components, 19
The Title Bar, 21
The Workspace, 18
Timezone (GMT), 15
Title Bar, 22, 27, 34, 36, 37,
66, 69
To, 15
toolset, 40
Topic, 15
training, 9, 10
transmitting disturbing sound, 29
Triangle, 42
triangle icon, 22

Typing a chat message, 60
UMTS, 9
Uninstalling the driver, 51, 53
upload, 10, 12, 25, 31, 43, 45,
46, 47, 69, 71
Upload Image, 25, 31, 71
uploading, 46, 47
Uploading an Image for Image
Mode, 31
URL Push, 19, 21, 57
user icon, 36
user type, 20, 34, 35, 67, 68,
69, 70, 72
user’s icon, 37, 69
Userlist, 19
Using Components, 22
Using the Whiteboard, 40
version 7, 26
video, 9, 10, 11, 19, 25, 26,
27, 28, 29, 30, 31, 32, 38,
43, 55, 60
videoconferencing, 9, 10
View Recordings, 16, 17
View Schedule, 15, 16
Viewing a recording, 16
Viewing a Recording, 66
Visit, 57, 58, 72
Visiting a URL, 58
web browsing, 10
web cam, 11, 25, 27, 31
web cams, 26
web conference, 12, 14, 27
web conferencing, 9
web content, 11
websites, 11, 19, 57
whiteboard, 10, 38, 40, 42, 71
widescreen, 31
Widescreen, 32
WiFi, 9
windows, 12, 14, 18, 23, 31,
32, 52
Work Alone, 38, 39, 71
Working Alone, 39
workspace, 22, 23, 24, 68, 69
Workspace, 21
Zoom Level, 25, 32, 33, 71
zooming, 43
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